
EPSON RC700A Startup Guide



The documentation, best practices, and recommendations provided by
READY Robotics do NOT constitute safety advice. Products sold through
READY Robotics are not by themselves a fully integrated workcell. As
required in ISO 10218-2, READY Robotics strongly recommends
performing a complete risk assessment of the integrated workcell per
ISO 12100. You may wish to use the methodology found in the ANSI/RIA
TR R15.306 Task-based Risk Assessment Methodology.
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OVERVIEW
This guide helps you set up your EPSON robot to work with Forge/OS 5.

You will complete these steps:

1. Check for the requirements.

2. Connect all the devices and power on.

3. Set up Forge/OS.

4. Transfer Forge/OS robot configuration files to the robot.

5. Configure the robot in RC+ and Forge/OS.

6. Program your robot with Forge/OS!

Note: This guide assumes that you have installed the robot following EPSON instructions.

Important: Before you start programming, please read the Known Issues section. The robot may behave
unexpectedly when near a singularity. THESE ISSUES ARE NATIVE TO EPSON AND NOT AT THE FAULT OF
FORGE/OS.
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HARDWARE REQUIREMENTS
Image Part Name Description Vendor Part Number

READY IPC

Hosts Forge/OS.

Note: READY offers two IPCs:
Forge/Hub and Forge/Ctrl
(legacy)

READY
Robotics

READY pendant The touch screen interface for
Forge/OS.

READY
Robotics 112563

READY pendant
Junction Box
(Forge/Ctrl
only)

Connects the READY pendant to
the Forge/Ctrl and robot controller.

READY
Robotics R-101257

12-Pin M12 to
Flying Leads
Cable

Connects to the READY pendant
Junction Box or Forge/Hub to
terminals.

READY
Robotics

Robot
Controller

Connects the robot arm to power
and to other devices. EPSON
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Image Part Name Description Vendor Part Number

USB A-Male to
B-Male Cable

Connects a Windows PC to the
robot controller.

EPSON

(Included
with
robot)

Windows PC
Required to load Forge/OS
configuration files to the robot
controller.

Emergency
Terminal Block
Kit (with Cable)

Connects the robot controller to
the READY pendant and safety
devices.

EPSON RE000975-1

24V/2.5A
Power Supply

Powers the READY pendant and
other devices.

Min./Max. current: 2.5/5.0 Amps.

e.g., Siemens
6EP1332-5BA00

Polycarbonate
Enclosure or
Cabinet

Protects the Terminal Block Kit and
the Power Supply in an enclosure.

Cat5e Shielded
Ethernet Cable
(x2)

▪ Connects the robot controller to
an IPC.

▪ Connects the READY pendant
to an IPC.

McMaster-
Carr 7734T6
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Image Part Name Description Vendor Part Number

USB Flash Drive
(with at least
2GB of available
memory)

Transfers Forge/OS configuration
files to the robot controller..

READY
Robotics

(or other)
R-400030
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SOFTWARE REQUIREMENTS
EPSON RC+ is the software that you use to communicate with the robot in its native language. Access to the full
version of RC+ came with the purchase of your robot. Install it on a Windows PC to load Forge/OS configuration
files.

Note: EPSON offers a free trial of RC+ for testing on a simulated robot. This free trial will NOT work for setting up
Forge/OS.

Important: If you have built or loaded projects on the controller before, you may need to do a factory reset.
Contact EPSON Support for help.

Refer to the table below for the minimum required RC+, controller firmware, and Forge/OS versions.

Controller Minimum Software Version

RC700/A
RC+ 7.0, Compiler v7.4.0.x

Firmware v7.5.3.0

Tip: Refer to Checking the Firmware Version for instructions on how to check your controller firmware version.
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CHECKING THE FIRMWARE VERSION
Follow these steps to check what firmware version your EPSON controller is on.

Plug the robot controller's power cable into a power outlet. Follow EPSON documentation for powering it on.1

Plug the USB Cable into the robot controller's PC port. Plug the other end into a Windows PC with EPSON RC+
installed.

2

Open EPSON RC+ in Program Mode.

▪ If you see the pop-up below, click Change To Program Mode before the 5 second countdown expires.

▪ If the default boot mode is set to Program Mode, wait for the 5 second countdown to expire.

3
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If you set a password, enter it. Then click OK.4

If you see a pop-up about monitoring controller operation before Program Mode boots, click Yes. If you see it
after Program Mode boots, click No.

5

If you see a pop-up about starting another session, click Yes.6
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If you see a pop-up about current tasks running, select Stop all tasks.7

In the top menu, select a Connection type of USB.

Tip: The USB option is only available when:
▪ You are using the full version of RC+.

▪ Your USB cable is connected to the robot controller and Windows PC.

8
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Go to Tools. Select Controller in the dropdown.9

Click Backup Controller.10
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Select the location where you would like to store your backup. Click OK.11

Click View Controller Status.12
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Select the backup file that you just created. Click OK.13

Find the Firmware Version.14

Verify that your firmware version matches the requirement. If you need to upgrade, contact EPSON Support.15
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CONNECTING THE ROBOT CONTROLLER
Plug an Ethernet cable into the LAN port on the robot controller. Plug the other end into a LAN port on your
IPC.

1

Plug one end of the EPSON Emergency Cable into the EMERGENCY port on the robot controller. Plug the other
end into the Terminal Block Kit.

2
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CONNECTING THE READY PENDANT
The READY pendant includes these safety outputs:

1. Key Switch (Robot Operation Mode)

2. Three-Position Enabling Switch

3. Emergency Stop Button

Note: For EPSON robots, you connect the READY pendant Emergency Stop, but not the Key Switch and
Enabling Switch. Always perform a risk assessment and use appropriate safeguards, like a safety fence.

Electric Shock Warning: Disconnect all components from power sources
before attempting this installation.
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If you are using a Forge/Ctrl, prepare the READY pendant Junction Box:

Connect a Cat5e STP Ethernet cable from the junction box Ethernet port (1) into a LAN port (5) on the
Forge/Ctrl.

a

Connect the 8-Pin power cable (4) from the junction box into one of the Module ports (6) on the Forge/
Ctrl.

b

Connect the 12-Pin flying leads cable to the safety port (3) on the junction box.c

1

If you are using a Forge/Hub, connect the 12-Pin flying leads cable to the Safety port on the Forge/Hub.2
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Wire the 12-Pin M12 Cable's flying leads to the Terminal Block Kit:

12-Pin Cable EPSON Emergency Connector Function

Brown N/A Enabling Switch

Blue N/A Enabling Switch

White N/A Enabling Switch

Green N/A Enabling Switch

Pink Pin 1 Emergency Stop

Yellow Pin 9 Emergency Stop

Black Pin 10 Emergency Stop

Grey Pin 14 Emergency Stop

Red N/A Key Switch

Violet N/A Key Switch

Grey/Pink N/A Key Switch

Red/Blue N/A Key Switch

Pin 2, 3 Jumper

Pin 15, 16 Jumper

Pin 4, 11 Jumper

Pin 12, 17 Jumper

3
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Wire the safeguard device (e.g., safety fence) and latching system. You can wire a button or switch to the latch
release pins to control the latching mechanism. Or you can jumper the latch release inputs so the safeguard
auto resets when you close the fence (shown in the table below).

EPSON Emergency
Connector

External 24V Power
Supply

Safeguard
Device Function

24V Safeguard
Contact 11 Safeguard Input 1 Circuit

Pin 7 Safeguard
Contact 12 Safeguard Input 1 Circuit

Pin 8 0V Safeguard Input 1 Circuit

24V Safeguard
Contact 21 Safeguard Input 2 Circuit

Pin 20 Safeguard
Contact 22 Safeguard Input 2 Circuit

Pin 21 0V Safeguard Input 2 Circuit

Pin 18 24V Latch Release Input
(Jumpered)

Pin 19 24V Latch Release Input
(Jumpered)

Tip: Refer to EPSON documentation for more information on safeguard wiring and pin assignments.

4

VERSION 5.3.0

© 2022 COPYRIGHT READY Robotics ALL RIGHTS RESERVED 19



POWERING ON
Plug the robot controller's power cable into a power outlet.1

Power on the robot controller.2

Plug your IPC's power cable into a power outlet.3

Power on your IPC.

Note: If you are using a Forge/Ctrl, turn the Power Disconnect Switch to ON. Then press the green power
button on the opposite side.

4
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SIGNING IN TO FORGE/OS
Follow these steps to pair the READY pendant with the IPC and sign in to Forge/OS 5.

If you need to install Forge/OS 5 on your IPC, stop here and follow all the steps in Appendix A, then come back
to these steps.

Tip: Forge/OS 5 is installed on all Forge/Ctrls and Forge/Hubs shipped after June 1, 2021.

1

The READY pendant automatically finds and pairs with the IPC. The three LEDs on the screen help you track the
status:

▪ Pendant Network Connection: This condition is satisfied when the READY pendant has a valid network
connection (i.e., the Ethernet cable is plugged in).

▪ Forge/OS IPC Detected: This condition is satisfied when the READY pendant detects a Forge/OS IPC on
the network.

▪ Forge/OS IPC Paired: This condition is satisfied when the READY pendant successfully pairs with the
IPC. If pairing fails, it is automatically retried indefinitely.

When a condition is not satisfied, the LED is red. When a condition is in progress of becoming satisfied, a
spinner around a READY logo appears to the right of the text. When a condition becomes satisfied, the LED
turns green.

The UI shows the real-time state of each step. For example, if the pendant loses its network connection during

2
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pairing, all steps become undone.

If the READY pendant spends more than 60 seconds on any step, troubleshooting text displays. Common things
to check are if the READY pendant network cable is plugged in, if the IPC is powered on, if the READY pendant
and IPC are connected to the same network, and if there's only one READY pendant and one IPC on that
network.

Tap Admin and sign in. The default Admin password is "forgeadmin".3

If Forge/OS is inactive, it opens the Settings app and prevents you from opening other apps. If you see the
screen below, follow Activating Forge/OS with a License Code in Appendix A.

4

With Forge/OS active, move on to the next section.5
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DEVICE CONFIGURATION - PT.1
In the Admin role, open the Device Configuration app.1

Tap New + to open the Device Library.2
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In the Device Library list, select EPSON industrial robot. Then tap NEXT.3
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Select RC700 for the Controller Model. Then select your Robot Model. Fill in the other information later.4

Insert a USB flash drive into the IPC as instructed on the screen. Use an empty flash drive with at least 2GB of
storage.

Tip: Do not connect the USB flash drive to the READY pendant.

5

Tap Start Transfer and wait for it to finish.6

Remove the USB flash drive when prompted.7
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IMPORTING THE PROJECT IN RC+
Insert the USB flash drive (that has the configuration files from the IPC) into the Windows PC.1

In File Explorer, go to your USB flash drive's storage. Open the forge-os folder.2
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In that forge-os folder, right-click the ready-epson-driver folder to copy it.3

In your Windows (C:) drive, open the EpsonRC70 folder that was made when you installed the EPSON RC+
software.

4
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In that EpsonRC70 folder, open the projects folder.5

In that projects folder, right-click to paste the ready-epson-driver folder that you copied.6
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Open RC+ in Program Mode.

▪ If you see the pop-up below, click Change To Program Mode before the 5 second countdown expires.

▪ If the default boot mode is set to Program Mode, wait for the 5 second countdown to expire.

7

If you set a password, enter it. Then click OK.8

If you see a pop-up about monitoring controller operation before Program Mode boots, click Yes. If you see it
after Program Mode boots, click No.

9
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If you see a pop-up about starting another session, click Yes.10

If you see a pop-up about current tasks running, select Stop all tasks.11

In the menu bar across the top of EPSON RC+, open the Project tab. Click Import.12
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Set the import location as PC. Then click Next.13

Select a project type of EPSON RC+ 7.x. Select the copied "ready-epson-driver" project. Then click Next.14
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Type "EPSON_DRIVER" in the Destination Project Name field. Then click Next.15

Select the Open Destination Project After Import checkbox. Then click Import.16
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CONFIGURING THE ROBOT
Expand the Connection dropdown in the top-right corner. Select USB to connect to your robot.

Tip: The USB option is only available when:
▪ You are using the full version of RC+.

▪ Your USB cable is connected to the robot controller and Windows PC.

1

In the top menu bar, select Setup. Go into System Configuration.2
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The Startup menu automatically appears. If Auto mode is not already selected, select it and click Apply.3

In the Controller menu, select Configuration:

Set the IP Address and Subnet Mask according to the READY IPC you have:

▪ Forge/Ctrl: set the IP Address to 172.16.255.251 and set the Subnet Mask to 255.255.255.0.

▪ Forge/Hub: set the IP Address to 192.168.1.20 and set the Subnet Mask to 255.255.255.0.

a

Select a Control Device of Remote I/O. This allows your robot to run through a READY pendant instead
of through a Windows PC.

b

Click Apply.c

4
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In the Controller menu, select Preferences:

Uncheck Virtual I/O to disable it.a

Uncheck Auto safeguard position recovery to disable it.b

Select Independent mode.c

Select Enable background tasks.d

Select Enable advanced task commands.e

Click Apply.f

5
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In the Inputs/Outputs menu, select Fieldbus Slave. Select a Fieldbus Type of Modbus TCP. Click Apply.6

In the TCP/IP menu, set the TCP/IP Ports to the values listed below. Use the same IP Address as earlier for
each port.

Set Port 201 to 49152, enter the correct IP address, then Apply.a

Set Port 202 to 49153, enter the correct IP address, then Apply.b

Set Port 203 to 49154, enter the correct IP address, then Apply.c

7

Click Close.8
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Open the Project tab. Click Properties.9

In the Compiler menu, expand the Compiler Version dropdown. Select 7.4.0.x (or later).10
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Click Apply, then Close out of the pop-up.11
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BUILDING THE DRIVER
It's time to build the driver. This step sends the program files to the robot.

In the top menu bar, open the Project dropdown. Click Build.1

If you see the prompt below, select Yes to overwrite the project on the controller.2
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Check that you have a successful build by looking for a "Build complete, no errors" message in the Status
window.

Tip: If you see build errors, refer to Appendix C: Troubleshooting.

3
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STARTING THE DRIVER
In the top menu bar, open the Run dropdown. Click Run Window.1

To start the driver in Remote I/O mode, click Enable Remote I/O.2
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In the pop-up below, click Yes to start BGMain.3
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DEVICE CONFIGURATION - PT.2
In these steps, you save the robot in the Device Configuration app and finish the setup.

Finish entering your EPSON device information.

Give your device a name.a

If you are using the READY-made Forge/Ctrl, enter the IP Address 172.16.255.251. If you are using the
READY-made Forge/Hub, enter the IP Address 192.168.1.20. If the IP address you assigned to the robot is
different, enter that.

b

1
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In Forge/OS, confirm your device settings and tap SAVE. Forge/OS attempts to connect with the robot
controller for up to 20 seconds.

Note: When you first connect to a robot, it's normal to see some robot errors and/or warnings on the
READY pendant. Ignore these for now. You will clear them after you finish adding the robot to Forge/OS.

If the robot controller fails to connect, you see this pop-up.

Click DISMISS, do the following, then try to tap SAVE again:
▪ Check the Ethernet connection between the robot controller and IPC.

▪ Check the network settings on the robot controller.

▪ Check if the robot controller is on and in the correct operating mode (in auto or remote mode).

▪ Select the correct robot controller and robot models in Device Configuration.

a

2

When the robot connects, you can add Tool Center Points (TCPs) or Payloads for the robot. You can come back
to this later by editing the device's configuration. Tap SAVE to continue.

Note: The default TCP is at the robot's tool flange. The default Payload is zero.

3

(Optional): Set up the robot controller's Input/Output (IO) signals for use in the Device Control Panel and Task4
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Canvas.

Enter a Display Name (i.e. "Open Machine Door", "Open Pneumatic Vise", or "Start Machining Cycle") to
show what each signal does in other apps.

a

If you want a signal to appear in the Device Control Panel, check the DCP box next to that signal.

Note: To use these I/O signals, integrate your I/O devices with the robot controller.

b

Tap SAVE. Forge/OS returns to the Configured Devices list, which shows the new robot as enabled.

Note: A device is enabled when its switch is green and toggled to the right.

c
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Congratulations! You are ready to control your robot in the Device Control Panel and Task Canvas apps.

Follow these steps to clear robot errors:

Tap the Device Status button on the Toolbar to expand the Device Status Panel. The robot is listed with
two buttons: MORE and RESET.

a

Tap RESET to try to recover from the errors. If you can't RESET an error, tap MORE to get more details
and instructions.

b

5
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CLOSING RC+
You can now control the robot arm with just the READY pendant. Follow these steps to disconnect your PC from
RC+.

Unplug the USB cable from your Windows PC and robot controller. A "Communication disconnection detected"
pop-up appears in RC+.

1

Check the READY pendant for errors, such as the "Communication Disconnection Between RC+ and Controller"
error. Follow these substeps to resolve it:

Tap the Device Status button on the Toolbar to expand the Device Status Panel. The robot is listed with
two buttons: MORE and RESET.

a

Tap RESET to try to recover from the error. If you can't RESET the error, tap MORE to get more details and
instructions.

b

2
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APPENDIX A: SETTING UP FORGE/OS

INSTALLING FORGE/OS
Follow these steps to install Forge/OS and sign in to the Admin role. Installation takes about 30 minutes,
depending on the resources of the IPC.

To install Forge/OS, follow these substeps. You need a Forge/OS installation USB flash drive. Contact your
READY Robotics distributor for an installation USB drive.

Important: Installing Forge/OS will erase all data on the target hard drive.

Connect a monitor, keyboard, and mouse to the IPC where you want to install Forge/OS.a

Plug the Forge/OS installation USB flash drive into the IPC.

Tip: If you need more USB ports, use a USB 3.0 hub.

b

Restart the IPC. While the IPC is powering on, press the keyboard hotkey that takes you to the Boot Menu.

Tip: The key that opens the Boot Menu depends on the IPC model. The most common keys that do this
are ESC, F10, F11, or F12. Refer to your computer's documentation for boot options.

Note: If you're installing Forge/OS on a Forge/Ctrl, press F11. You may need to enter the BIOS Admin
password. Contact READY Support if you run into this issue.

c

From the boot options, select Install Forge/OS to boot from the installation USB flash drive.d

1
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The installer may take several minutes to load. Wait until the installation wizard opens.e

Select your language. Then click Install Forge.f

Choose a keyboard layout. Then click Continue.g
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Select Minimal installation. Uncheck Download updates while installing forgeos. Then click Continue.h

Select Erase disk and install forgeos. Then click Continue.

Note: If Forge/OS is already installed, the installation wizard will show additional options. The goal is to
erase the entire disk for a brand new installation.

i
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Select the IPC hard drive for Forge/OS and click Install Now.j

Confirm that you want to erase the entire disk by clicking Continue.k

Make a note of the pendant instructions. If you're using a Forge/Ctrl, select the checkbox next to This
hardware is a Forge CTRL.

l
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Choose your timezone. Then click Continue.m

Choose your IPC's host name. The host name identifies the IPC on the network. Pick a username and
password. Then click Continue.

Note: The username and password that you create here are for accessing the IPC desktop. They are
NOT for signing into Forge/OS on the READY pendant.

n
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Wait for the installer to copy and install Forge/OS.o

Once the installation completes, click Restart Now.p

When prompted, remove the installation flash drive. Then reboot.q

Wait for Forge/OS to finish booting.r
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When you see the login screen with the Forge/OS 5 logo, Forge/OS is ready to run on the
READY pendant! You don't need to sign in to the desktop. Disconnect the monitor, keyboard, and mouse
that you used to install Forge/OS.

s
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The READY pendant automatically finds and pairs with the IPC. The three LEDs on the screen help you track the
status:

▪ Pendant Network Connection: This condition is satisfied when the READY pendant has a valid network
connection (i.e., the Ethernet cable is plugged in).

▪ Forge/OS IPC Detected: This condition is satisfied when the READY pendant detects a Forge/OS IPC on
the network.

▪ Forge/OS IPC Paired: This condition is satisfied when the READY pendant successfully pairs with the
IPC. If pairing fails, it is automatically retried indefinitely.

When a condition is not satisfied, the LED is red. When a condition is in progress of becoming satisfied, a
spinner around a READY logo appears to the right of the text. When a condition becomes satisfied, the LED
turns green.

The UI shows the real-time state of each step. For example, if the pendant loses its network connection during
pairing, all steps become undone.

If the READY pendant spends more than 60 seconds on any step, troubleshooting text displays. Common things
to check are if the READY pendant network cable is plugged in, if the IPC is powered on, if the READY pendant
and IPC are connected to the same network, and if there’s only one READY pendant and one IPC on that
network.

2
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Note: After installation, you have limited access to Forge/OS until you activate it with a license code. See
Activating Forge/OS with a License Code.

Tap Admin and sign in. The default Admin password is "forgeadmin".3
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ACTIVATING FORGE/OS WITH A LICENSE CODE
There are two methods to activate Forge/OS: Online license activation and offline license activation.

The table below lists the requirements for each method.

Online License Activation Offline License Activation

▪ An internet-connected Forge/OS
▪ A valid Forge/OS license code

▪ A 2GB or larger USB flash drive

▪ An internet-connected PC

▪ A valid Forge/OS license code

Tip: Connect a USB keyboard to the port on the bottom of the READY pendant to type in any text field in Forge/
OS.

On the Settings app main screen, tap License.1

Type in your license code.2
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Choose ONLINE LICENSE ACTIVATION if Forge/OS is connected to the internet. If not, choose OFFLINE
LICENSE ACTIVATION.

3

If you chose online license activation, you're done!4

If you chose offline license activation, follow these substeps:

Insert the USB flash drive into your IPC. Tap START WRITING CERTIFICATE TO USB DRIVE.a

5
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When the files finish transferring, tap NEXT. Follow the instructions on the screen to convert the
Activation Certificate to an Unlock Certificate using an internet-connected PC.

b

Insert the USB flash drive back into your IPC. Tap UNLOAD UNLOCK CERTIFICATE FROM USB DRIVE.c

Wait for the file to finish transferring. When the file transfer is complete, remove the USB flash drive and
tap SAVE.

d

Forge/OS returns to the licensing home screen and shows an active license. If the license status isn't
active, restart these license activation steps. Double-check your license code.

e
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CHOOSING PREFERENCES
These steps help you choose system preferences, including language, units, time, and network settings.

To change preferences for the first time, go to General Settings:

On the Settings app main screen, tap General Settings.a

Change the Units of Measure, Time and Date settings, or the Admin login password.

Note: If you later forget your password, contact READY Robotics to reset it.

b

Tap SAVE to save changes and exit the General Settings menu.c

1
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APPENDIX B: KNOWN ISSUES
You may encounter programming issues when the EPSON robot comes near a singularity. THESE ISSUES ARE
NATIVE TO EPSON AND ARE NOT CAUSED BY FORGE/OS.

What is a singularity? A singularity is a position that prevents a robot from making certain movements. A
singularity can occur when two or more joint axes are co-linear, such as the axes of Joint 4 and Joint 6.

In a singularity, a robot cannot reach a specified waypoint due to physical limitations. This doesn't mean that it
can't reach the waypoint, but it is unable to move to the position in that way.

Important: When you move a robot near a singularity, the robot may move unexpectedly, speed up, or enter an
error state.

Two behaviors you may see near a singularity are excess jogging and rejected stop requests.

EXCESS JOGGING AT A SINGULARITY
When you jog the robot near a singularity, the robot may move for an extra 1-2 seconds after letting go of the jog
button.

This issue is the common with linear jogs on EPSON robots. Linear jogs move the robot's tool center point (TCP)
in the Cartesian space (X, Y, Z, Rx, Ry, Rz). Use joint moves around singularities.

When jogging the robot near objects, use a low speed to avoid unpredictable collisions.
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STOP REQUESTS REJECTED BY THE ROBOT
When the robot is moving through a singularity, it might not immediately stop with the READY pendant Stop
button or with an external safety device (such as a light curtain or a safety fence). However, the robot will always
immediately stop with the E-Stop.

Important: In emergency situations, ALWAYS hit an emergency stop button that is wired to the emergency stop
circuit of the EPSON controller.

For example, if you execute a circle move that has an arc point near a singularity, the robot might finish its entire
path of programmed motion regardless of any stop signal it receives (other than the E-Stop).

To minimize risk, use a low speed as you first build out your task. This will help avoid unpredictable collisions.
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APPENDIX C: TROUBLESHOOTING
Use this section to recover from an unresponsive robot or from build errors.

DRIVER KILL SWITCH FOR UNRESPONSIVE ROBOT
If a port fails to configure when you load the driver, you may lose all connection to the robot when you reboot.

To shut down an unresponsive driver, set IO23 (pin 27) to HIGH by making these connections:

▪ 0V to Pin 14 (Input common)

▪ 24V to Pin 27 (Input No. 23)

Tip: To check if IO23 is set to HIGH, open the I/O Monitor from the Tools menu. In the pop-up,
select All Inputs. Check if there's a red dot next to input 23.

While IO23 is set to HIGH, restart the robot. This setting prevents the driver from launching when the
robot powers up, allowing you to reconfigure the robot. The Runtime Controls window reads "Kill
switch enabled, disable to start driver" until you set IO23 back to LOW (turning the red dot off).
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INITIAL DEVICE CONFIGURATION ERROR
When you set up your robot for the first time, you may see build errors.

Try deleting and re-adding the robot in System Configuration.
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In the top menu bar, select Setup. Go into System Configuration.1

Expand the Controller menu. Open Robot 1. Note what the settings of the configured robot are. If they
don't match your robot model, make a note of that.

2

Click Delete and Yes to re-configure the Robot 1 file.3
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Click Add. Enter the robot's information. Then click OK.4

Close out of the System Configuration menu.5

Rebuild the project (as outlined in the next section).6
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REBUILDING THE SOURCE CODE
You need to rebuild the source code:

▪ after you resolve a build error.

▪ if the Epson encounters a stack error in the Epson logs while you are running a task. When this happens,
you will receive a Forge/OS message asking you to rebuild.

In the top menu bar, open the Project dropdown. Click Rebuild.1
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If you see the prompt below, select Yes to overwrite the project on the controller.2

Verify that you have a successful rebuild by looking for "Build complete, no errors" in the Status window.3
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Start the updated driver. Navigate to the top menu bar, open the Run dropdown, and click Run Window.4

To start the driver in Remote I/O mode, click the Enable Remote I/O button. Click Yes in the pop-up
window.

5
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DIGITAL OUTPUT CONFIGURED AS SYSTEM OUTPUT ERROR
You may see a "Digital Output Configured as System Output" error in Forge/OS or an "Error 2342: Cannot
change the status for output bit configured as remote output" in RC+.

For example, suppose you have Output 0 linked to the "Ready" signal. In the I/O Monitor, output bit
#0 has the label "Ready". On the READY Pendant, if you select the DCP checkbox next to Output 0 in
the robot's device configuration and then try to change the state of Output 0 in the robot's Signals
tab in the Device Controls app, you will get an error.

Follow these steps to unlink Output 0 (or other outputs) in RC+.

In the top menu bar, click Setup. Go into System Configuration.1
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In the Controller menu, select Remote Control and then Outputs.2

Configure the output signals to an output bit (or select "Not used").

Note: You cannot select Output #8 or #9. These outputs are reserved by Forge/OS.

3
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APPENDIX D: ERROR RECOVERY
Some errors are not recoverable from Forge/OS. One such error is Error 4066: "Motion Command was attempted
in the prohibited area depended on joint combination." This error occurs when you move the robot outside of its
joint limits.

In these situations, the robot is not movable in Forge/OS or in the EPSON RC+ Robot Manager. In this case, use
the instructions below to recover your robot to an operable state.

Restart RC+ by closing out of it and re-opening it in Program Mode.1

If necessary, reload your project:

In the top menu bar, open the Project dropdown.a

Expand the Recent Projects menu.b

Select the EPSON_DRIVER file.c

2

If you see a pop-up asking if you want to disconnect from the controller, click No.3
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In the top menu, go to the Tools menu. Open the Command Window.4

Turn motors off.

In the Command Window, type “Motor Off”, then hit Enter.a

5

Turn a joint brake off.

Check which joint is out of the movable zone or in a state that it cannot move.a

6
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In the Command Window, type "Brake Off, [JOINT#]", then hit Enter. For example, to release the joint 3
brake:

Note: Depending on which joint that you are releasing the brake for and what position that joint is in,
you may need to catch the robot as it falls. Avoid damage to the robot and any nearby objects that it
might collide with.

b

Move the joint and turn its brake back on.

Use your hands to move the joint back within the movable zone.a

In the Command Window, type "Brake On, [JOINT#]", then hit Enter.b

7

Turn motors on.

In the Command Window, type "Motor On", then hit Enter.a

8

Restart the driver in Auto Mode.9
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RESOURCES
Want to learn more about how Forge/OS can empower you?

Visit READY.academy (ready.academy) for FREE hands-on courses to help you deploy a robotic system.

Visit READY.market (market.ready-robotics.com) for products and services offered by READY and our partners.

Visit our Support site (support.ready-robotics.com) for robot startup guides, FAQs, and more.

Visit our Resources page (ready-robotics.com/resources) for articles, whitepapers, and other resources.

If you encounter a problem and need to talk to someone, reach out to us.

▪ Email READY Robotics: support@ready-robotics.com

▪ Call READY Robotics: +1-833-732-3977
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